
[bookmark: _Toc404177508]ABOUT THE DOCUMENT THAT FOLLOWS
Last update: June 1, 2016
Updated in summer of 2016, this template is a “starter kit” for formatting your thesis in Microsoft Word.  It incorporates Word’s auto-generate capability for the Table of Contents, List of Tables, and List of Figures.  It also includes a workaround for automatic numbering of equations.

It has correct margins and page numbering, appropriate formatting of the front pages (often the area with the greatest number of formatting errors), chapter and section headings in acceptable formats, and heading and subheading styles set up through subheading level 3.

It also offers some tips, usually in red text boxes that can be easily deleted before you print.  IMPORTANT:   you must be in the Print Layout View (under the View menu) to see or delete these red text boxes (also called “help boxes” or “instructional text boxes” herein).

We suggest that you use the template as a starting point for the format of your thesis, consulting the Graduate Thesis Manual at all times for proper formatting. 
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[To the students of the Georgia Institute of Technology]

This is the (optional) Dedication page.  If your thesis contains a Dedication, it would replace the text above.  The text should be centered both vertically and horizontally on the page and should be single-spaced.  The Dedication page DOES NOT have a heading or a printed page number, but the page DOES count in the page numbering.  Since the Dedication bears no heading or page number, it is not listed in the Table of Contents.

DELETE THIS INSTRUCTIONAL TEXT BOX BEFORE PRINTING.

DELETE THIS WHOLE PAGE IF YOUR ARE NOT INCLUDING A DEDICATION IN YOUR THESIS.
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The Acknowledgements page should be double-spaced and is the first page to bear a printed page number and be listed in the Table of Contents.

DELETE THIS INSTRUCTIONAL TEXT BOX BEFORE PRINTING.





About the page number on this page:
Most often, the Acknowledgements will be page iv, but if you have no Dedication page or you have additional front matter, such as an Epilogue, you may have to change this page number.

To do so, double-click above the page number to edit the Footer area.  Right-click the page number and click “Format page numbers…” and change the page number in the “Start at” box from iv to whatever number your Acknowledgements page is.  Page numbering should continue correctly from there.

DELETE THIS INSTRUCTIONAL TEXT BOX BEFORE PRINTING.
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LIST OF TABLES
	Table 1
	– This table is provided as an example.
	3

	
	
	

	
	
	




By utilizing Word’s “Insert Caption…” feature, you can easily build your List of Tables (this page) and List of Figures (following page).  To streamline the formatting of the “List of Tables,” the label and number, caption, and page number appear in columns 1, 2, and 3, respectively, of the table above.  If you cannot see the table gridlines, select the table, go to the “Layout” menu and select “View Gridlines.”

In the first column, you can insert the Label and Number of a Figure by using the “Cross-Reference” tool in the “References” menu.  Click “Cross-reference,” select “Figure” or “Table” from the drop-down menu, and select the desired information to be included from the drop-down menu “Insert reference to:”  In the second column, the corresponding figure caption should be inserted.  In the final column, insert the page number.

To update all fields prior to submitting your document, simply select the table, right click the text, and select “Update Field.”

DELETE THIS INSTRUCTIONS TEXT BOX BEFORE PRINTING.

[bookmark: _Toc450824205]LIST OF FIGURES
	Figure 1
	– This is a figure.
	3





[bookmark: _Toc450824206]LIST OF SYMBOLS AND ABBREVIATIONS
	A
	the letter A

	B
	the letter B

	C
	the letter C

	D
	the letter D


[bookmark: _Toc450824207]
SUMMARY
[bookmark: _Toc439062360]Start typing the summary here.  Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam porta euismod pharetra. Cras a rhoncus eros. Etiam leo libero, hendrerit in posuere at, fermentum vitae nisi. Etiam id euismod lorem. Aenean purus dolor, dignissim eu scelerisque vitae, tincidunt ac diam. Sed semper est nec est viverra, id placerat nisl porta. Nullam luctus placerat ornare. Cras rutrum, tortor vestibulum tincidunt consequat, nunc nibh sollicitudin sem, ut viverra odio risus quis orci. Pellentesque viverra sed risus id blandit. Pellentesque rutrum suscipit nisi, nec eleifend orci volutpat scelerisque. Vestibulum dignissim, est vitae placerat viverra, urna massa lacinia sapien, nec vulputate turpis neque vitae magna.
DELETE THE ABOVE TEXT BUT BE SURE TO RETAIN THE SPACING.

The Summary is the last of the Preliminary pages.
The Summary may have the same content as the doctoral Abstract but the format is different.  The Abstract is an external document you prepare forGeorgia Tech.  The Summary is part of the body of your work and so the Summary must have the same spacing as the body of the thesis (generally double-spaced).
DELETE THIS INSTRUCTIONAL TEXT BOX WHEN DONE.
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[bookmark: _Toc450824208]Introduction
This is the first chapter of your manuscript. Often it is titled, 'INTRODUCTION'. Some departments’ style guides require that the first chapter is titled 'INTRODUCTION,' but otherwise, you may use any title that suits your purpose. A chapter heading uses the “Heading 1” quick style.  Using this style will allow Word to auto-populate the Table of Contents.
[bookmark: _Toc98324476][bookmark: _Toc450824209]How to Use This Template [This is a First-Level Subheading]
The first-level subheading utilizes the “Heading 2” quick style.  Using this style will include your first-level subheading in the Table of Contents. This template file has been set up to meet the formatting requirements for theses and dissertations given in the Georgia Tech Graduate Thesis Manual.  It's not magic, but it does get some of the confusing stuff taken care of: the margins are correct; the table of contents is formatted correctly; the necessary parts are in the right order; the page numbers will appear in the right place and in the right form; it has an acceptable font face and size. Further, Appendix A has a description of the scheme for subheadings you should use if your departmental style guide doesn't specify one.
[bookmark: _Toc450824210]This is a Second-Level Subheading
Second-level subheadings utilize Heading 3.  It will be pretty obvious when you need to get rid of some text in this template. For example, this part of the introduction needs to go before you start typing. Easiest way to delete it is to click your cursor in front of the first paragraph, scroll down to the last line in the chapter, hold the SHIFT key down, and click after the last letter. 'SHIFT-clicking' like this selects everything between the two clicks.
[bookmark: _Toc450824211]Inserting and Numbering Equations
To insert an equation to be referenced in the text, use the three-column table shown below.  This table has been added to the “Auto Text” menu accessed through “INSERT”   “Quick Parts.”  Equations are generally described and referenced in the text as is done in the following sentence.  Equation 1 below describes the relationship between the need for a vacation, , and the available time to take a vacation, .  The equation number (1) that appears in the table is a sequential field code which allows equation numbers to update automatically by right-clicking highlighted text and selecting “Update Field.”  When adding an equation, select the number and bookmark it under the “INSERT” menu.  When you reference the equation in the text (i.e. “Equation 1 describes something”) you can insert that bookmark so numbers will automatically update.
	
	
	[bookmark: Eq1](1)


[bookmark: _Toc450824212]Inserting, Numbering, and Referencing Figures
When you insert an image into the text, it will look like Figure 1 below.  In the previous sentence, a figure reference is inserted by cross-referencing the figure label and number (INSERT  Cross-reference  Reference Type: Figure  Select figure entry and choose Insert reference to: Only label and number).

[bookmark: _Ref402970151][bookmark: _Toc438735445][bookmark: _Toc450572456][bookmark: _Ref439056385][bookmark: F1]Figure 1 – This is a figure.  The “caption” uses the “Caption” theme from the quick styles menu above and is added by right-clicking the figure and selecting “Insert Caption...”
[bookmark: _Toc450824213]Inserting, Numbering, and Referencing Tables
After a table is inserted, it must be captioned by selecting the Table and right clicking.  Then click on “Insert caption…” The process is similar for captioning a figure except for the fact that a Table’s caption appears ABOVE the table as opposed to the figure caption appearing below a figure.  An example of a table is given in Table 1 below.  By inserting the cross-reference to the table (i.e. Table 1), the numbering will be done automatically.
[bookmark: _Ref409521990][bookmark: _Ref409521963][bookmark: _Toc438733587][bookmark: _Ref439055363][bookmark: _Ref439055321][bookmark: T1]Table 1 – This table is provided as an example.
	A
	B
	C

	1
	5
	9

	2
	6
	10

	3
	7
	11

	4
	8
	12


[bookmark: _Toc450824214]Things to be Careful of
You can goof up the template. For example, when you delete the text on a page, be careful not to accidentally delete the marker, called a 'page break,' between the chapters or different types of pages. The page break marker makes your new chapter begin at the top of a page, no matter what editing you do before them. .If you delete a section break, related to a page break, you may lose any formatting that was particular to that page.
Using Tabs Correctly [This is a Third-Level Subheading]
When you put your headings into the Table of Contents, List of Tables, etc. things should line up pretty well if you use tabs to skip to the next column. If you use spaces to indent or move to the next column, you will have a mess. As spaces in most font families are not fixed in size, things won’t necessarily line up perfectly and you may be required to fix it.  Moreover, when you use spaces rather than tab settings to determine placement of text, any change in words, fonts, or margins requires a great deal of work to reformat.  If you use tab settings to control placement, making such changes becomes trivial. 
Because of the way tabs are set, if a chapter title or section name in the Table of Contents is very short, you may have to put an extra tab character to get the cursor to jump correctly. 
Using the Styles
	The page and section heading styles have been set up as named styles in Word.  The page headings in the preliminary pages (e.g. “Table of Contents”), each chapter heading (e.g. “Chapter 1: Introduction”), and the back page headings (e.g. “References”) all use a style called “Heading 1“.  The first-level subheadings (example above) use a style called “Heading 2”.  The second-level subheadings use a style called “Heading 3”. The third-level subheadings use a style called “Heading 4”.  If you accidentally delete any of those headings, go to the Format/Style menu, select the appropriate style and “Apply”.  If you cannot find the style under the list of styles, change the pull-down below it called “List” to “All styles”.

[bookmark: _Toc450824215]Setting up a new chapter
	How do you begin a new chapter using this template? What must you do to get the page numbers to act correctly? Below are the steps for making a new chapter. 
[bookmark: _Toc450824216]Moving to a New Chapter
	To move to a new chapter, you must tell Word that you are moving on to a new page. You do this by inserting a page break. A page break forces the next line of text to appear at the top of a fresh page.
[bookmark: _Toc450824217]How to Insert a Page Break
1. Go to the end of a chapter. That means, put your cursor after the very last character of that chapter.
2. Hit Return to move to a new paragraph.
3. From the Insert menu, choose Page Break.
	If you are in Outline View (see View menu), you'll see a dotted line across the screen. That marks the end of the previous page. If you are in Page Layout view, you'll just see the top of a new blank page. 
	Begin typing. If you are in Page Layout view, when you get to the end of the first page, your text will skip to the next page. A page number will appear at the bottom center of the new page. The number will be gray, and you can't edit it. That's OK; that is the way it's supposed to look on the screen.


[bookmark: _Toc450824218]APPENDIX A. DESCRIPTION OF DEFAULT SUBHEADING SCHEME
	This appendix illustrates the default style of subheadings as described in the Graduate Studies Thesis Manual, available at http://www.grad.gatech.edu/thesis. Your department may have its own style guide and its own way of formatting subheadings. Whichever scheme you use, you must use it consistently throughout the document or the Graduate Thesis Office will require you to make revisions until it is acceptable.
	The default format for chapter-level headings is bold, all upper case, and centered.  Otherwise the font is the same font family and the same size or no more than 2 font points larger (e.g. 14 points vs. 12).
[bookmark: _Toc98324478][bookmark: _Toc450824219]A.1 	First-Level Subheading
	The default format for first-level subheadings is left-justified, bold, and upper and lower case (UC/LC) .  Alternatively, you may use plain (not bold), and all upper case (UC).  The former of the two is built into this Word document.  In either case, it should be the same size as the text font.  If you use upper/lower case, capitalize words as you usually would in a title.
	A blank line above the subheading has already been built into this template so it is not necessary to leave another blank line before headings so long as you are using the proscribed heading and subheading styles.  Styles were discussed in Chapter 1 of this document.
[bookmark: _Toc450824220]A.1.1	Second-Level Subheadings
	Second-level headings are also justified left.  If the first-level subheading was UC/LC and bold, the second-level subheading will be UC/LC and italicized.  That is the style built into this Word document.
	Since a blank line above each subheading was built into this template, it is not necessary to leave another blank line before headings so long as you are use the proscribed subheading style.
A.1.1.1	Third-Level Subheadings
	Third-level subheadings are plain UC/LC text and underlined. Capitalize as with the other subheadings. 
A.1.1.1.1	Fourth-Level Subheadings
	Fourth-level subheadings, if needed, should be plain UC/LC text, flush left. 



[bookmark: _Toc450824221]REFERENCES
It is highly recommended that you use some sort of reference manager when using the Word template.  The Georgia Tech library offers tutorial classes for EndNote, a powerful reference manager.  Capabilities include automatic formatting of the Reference page and citations.

If your discipline utilizes a different display format (e.g. references listed at the end of each chapter), you may do so.  But it is preferred that they all appear at the end of the document on this REFERENCES page.

In general:  You can use whichever style of references is used in your discipline, whether by alphabetical or by numbered citation. You can adjust the indentation by sliding the ruler 'nibs' on the ruler bar at the top of this window, if needed.
This template uses single spacing within the entries and doubles spaces after each one. These can be modified under Format | Paragraph but please note that double-spacing between entries and single-spacing within entries is required regardless of which method of citation and referencing you choose.
Select the first paragraph of the desired style and replace it with your first entry. When that entry is finished, hit Return to move to a new paragraph.  Delete any other surrounding text. 
This reference is formatted using a widely-used style called 'hanging indent.' The first line of each entry lines up with the margin. The other lines indent, causing the first line to 'hang'.
The “hanging indent” style is usually used when references are listed alphabetically by author in the “References” list and cited by author(s) and date within the text. 
Anon., “Example of a web citation”, www.thesis.gatech.edu/web_citation.html (Accessed June 30, 2005). [to remove the color and underline from the url name (required) you can either select Insert/Hyperlink and “Remove Link” or go into the Format/Style menu and modify the style named “hyperlink”.  The latter will leave the actual link intact.
The following style is used when citations in the text are numbered sequentially and the “References” list is ordered numerically, generally “in order of appearance”.  Delete style not selected.

[1]	AMITAY, M., HONOHAN, A. M., TRAUTMAN, M., and GLEZER, A., “Use of small caps in numerical citation,” AIAA Paper 97-2004, Presented at the AIAA Shear Flow Control Conference, Snowmass, CO, 1997.
[2]	BROWN, G. L. and ROSHKO, A. “The effect of names in full upper case in numerical references,” J. Fluid Mech., vol. 26, pp. 225–236, 1966.
[3]	Maslen, P.E. and Gordon, M. Head., Chem. Phys. Lett. 283, 102 (1998)..
[4]	Anon., “Example of a web citation”, www.thesis.gatech.edu/web_citation.html (Accessed June 30, 2005). [To remove the color and underline from the url name (required) you can either select Insert/Hyperlink and “Remove Link” or go into the Format/Style menu and modify the style named “hyperlink”.]  The latter will leave the actual link intact.
We hope that this thesis template is useful to you, but we understand that it may not work perfectly across versions or when tweaked by the user.  Unfortunately, the Office of Graduate Studies is not staffed to offer troubleshooting assistance on this or any template.  They are simply tools provided by current and former students for the benefit of future students.
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